PalTalk 5.0
GUIDA PER L’UTENTE

CHE COS’E’ PALTALK
PalTalk è la soluzione internet totale di comunicazioni che combina il meglio della messaggeria di comunicazione e telefonia internet. PalTalk offre una serie ampia di caratteristiche che permettono agli utenti di comunicare l'un con l'altro in qualsiasi parte del mondo in qualsiasi momento - tutto gratuitamente.

PalTalk abilita in qualsiasi parte del mondo chiamate gratis a, con qualità di suono di avanzamento. Anche più, PalTalk abilita chiamate video in vivo, stanze di chiacchierata a voce, messaggistica istantanea e molto ancora. Noi siamo lieti di stare lanciando Multivideo con PalTalk 5.0 che abilita sino a 6 video simultanei in una audioconferenza. PalTalk 5.0 ora è disponibile per Versione Pubblica.

PalTalk è un servizio gratis. Usalo e divertiti. 

INSTALLAZIONE
Come partire
Interfaccia utente
Come usare PalTalk
INSTALLAZIONE E LOGIN CON PalTalk
Passo 1
Assicurati di aver scaricato PalTalk sul tuo desktop: quindi fai doppio click sull’icona “ pal_install “ sul desktop. Puoi effettuare l’intera operazione attivando il link http://199.106.234.148:8080/join/jsp/join.jsp?source=4 
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Passo 2 
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Ti apparirà una schermata di login. La scritta nuovo utente <New User>  apparirà nella finestra del soprannome (Nickname); se ciò non fosse basta cliccare nel menu a tendina e selezionarla. 
Passo 3
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Una volta selezionato  <New User> dovresti notare che l’ area della password si è colorata di grigio . Ora clicca sul bottone di conferma  'Sign On' per iniziare la registrazione .
Passo 4
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Una schermata che chiede le informazioni per l’utente ; dopo averla riempita si può passare avanto con il bottono “ Next “
Passo 5
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A questo punto appare una finestra di dialogo interessante. You will now see an interests screen, ne spunti due e passi avanti con il bottone  'Next' 
Passo 6
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Questo ti porterà alla page finale dell’offertas. This will bring you to the final offers page. Scegli l’offerta speciale che vorrai ricevere e quindi clicca sulla fine. A questo punto sei pronto per incominciare con PalTalk.
IMPOSTAZIONI DI PARTENZA
Provare l’AUDIO
Aggiungere un’amico alla lista personale
Inviare un messaggio istantaneo
Effettuare una chiamata telefonica uno-a-uno
Effettuare un collegamento video uno-a-uno
Associarsi a un gruppo
Guardare e pubblicare un multivideo
Inviare un invito ad un amico per aggregarsi a PalTalk
PROVARE IL VOSTRO AUDIO
Quando usate per la prima volta  PalTalk è buona pratica andare a testare il vostro audio per essere sicuri che la vostra voce e il sistema sonoro sia correttamente configurato per l’uso con PalTalk. L’  Audio Test è anche utile se già state usando Pal Talk e avete problemi audio.
Passo 1
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Clicca su  PalTalk's 'Help' menu and scegli 'Audio Test'.
Passo 2 
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Apparirà una finestra con una breve spiegazione del test audio, clicca sul bottone “ Next “ per passare alla finestra successive. 
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Passo 3
Questa finestra serve per assicurarsi di avere l’hardware necessario per usare PalTalk. Una volta verificato ciò clicca sul bottone “ Next” 
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Passo  4
Questa finestra nverificherà l’input sonoro. Clicca sul bottone  'Play a Sound' , e dovresti sentire un rumore di tamburo  
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Passo 5
Puoi aggiustare il suono muovendo il cursore del volume posto sulla destra sino a quando il suono risulta più gradevole. 
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Passo 6
Clicca il bottone  'Next' per passare alla successive finestra

Passo 7
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Questa finestra serve a verificare il funzionamento del tuo microfono. Clicca sul bottone “ Record “ (or tieni abbassato il tasto  'Ctrl' della tua tastiera) e comincia a parlare davanti al tuo microfono.
Passo 8
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Clicca sul bottone “ Play” e dovresti sentire nelle tue casse o nella cuffia la tua voce che precedentemente hai registrato .
Passo 9
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Puoi regolare il livello del microfono muovendo il cursore  'Mic Vol' sulla destra sino a quando non avrai ascoltato la tua voce chiaramente.
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Passo 10
Se non capti alcun suono clicca sul bottone “ Senti qualcosa?”  'Did you hear anything?' e riprova a registrare ancora.
Passo 11
Una volta contento dell’input del tuo microfono clicca sul bottone “ next” .
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Passo 12
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Se non sei ancora contento dell’impostazione del suono puoi ancora sistemarlo con un click sul bottone  'Audio Settings' sulla finestra finale. Questa aprirà un mixer audio con il quale potrai sistemare manualmente l’audio. 
passo 13
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Infine clicca su  'Finish' e il tuo test audio è completo.
AGGIUNGI UN CONOSCENTE ALLA TUA LISTA AMICHEVOLE (buddy) 
PalTalk ti consnete facilmente di tenere traccia di quelli tra I tuoi amici che sono collegati on line mentre tu sei contemporaneamente on line. Si usa il concetto di lista buddy . Tu puoi aggiungere le persone alla tua lista buddy una sola volta e quindi da questo momento in poi tu sei automaticamente avvisato di quando si collegano o scollegano.
Per aggiungere qualcuno alla lista buddy, chiedi a PalTalk di cercare attraverso la lista degli utenti registrati. Tu devi come minimo fornire una parte o entrambi i nickname, l’indirizzo e.mail e/o il cognome.
PalTalk ti mostrerà una lista di persone che si accorda con I tuoi criteri di ricerca. Puoi così localizzare i tuoi amici nella lista e chiedere a PalTalk di aggiungere questa persona alla tua lista buddy.
Passo 1
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Seleziona l’icona “ add pal “ dalla finestra principale di PalTalk. Si apre una finestra pop-up per l’inserimento dei dati della ricerca. 

Passo 2 
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Digita ciò che conosci della persona che stai cercando. Puoi specificare tutto o parte del suo nickname , la sua e.mail o il nome della persona stessa. Pigia il bottone di ricerca
Passo 3 
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Tutti gli utenti registrati che si accordano con I criteri di ricerca d ate specificati sono elencati nella finestra dei risultati della ricerca. Seleziona le persone che vuoi inserire cliccando sul loro nickname nella lista e quindi pigia il bottone “ add pal “
Passo  4
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Gli utenti che hai aggiunto dovrebbero apparire ora nella tua lista buddy nella finestra principale di PalTalk. Essi figureranno sia nello stato ondine di collegamento sia nello stato di offline quando non sono connessi. 
COME INVIARE UN MESSAGGIO ISTANTANEO
PalTalk ti consente tutti I tipi di comunicazione con I tuoi amici .Usando PalTalk puoi facilmente conversare vedere e chattare e scambiare file con tutti I tuoi amici in ogni parte del mondo. 
Il modo più semplice per fare una di queste cose è di aprire una finestra di comunicazione con il tuo amico. Ci sono molti differenti modi di aprire una finestra di comunicazione:
· Clicca con il tasto destro del mouse sul nickname e scegli l’opzione nel messaggio di testo 
· Se hai utilizzato il doppio click per aprire la finestra di comunicazione, semplicemente fai doppio click su uno dei nikname dei tuoi amici. 
· Dall’interno di una finestra di gruppo, con il tasto destro del mouse clicca su un nome componente e scegli la chat privata. 
· Dall’interno di una finestra di gruppo evidenzia un nome di un componente e pigia il bottone Private. 
Quando una finestra di comunicazione è aperta, semplicemente digita ciò che vuoi inviare al tuo amico nel riquadro di testo in basso, premi il tasto Enter e ciò verrà inviato. Sia il tuo testo personale sia la risposta del tuo amico appariranno nel riquadro immediatamente superiore.. 

Step 1
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Scegli la persona a cui vuoi inviare un messaggio scritto e pigia il bottone  Text/video. Si aprirà una finestra per comunicare con questa persona.
Step 2 
Nell’are in basso riservata alla scrittura, digita il messaggio di testo e quindi premi il bottone Text per inviarlo (oppure più semplicemente premi il tasto enter della tastiera)
[image: image3.png]=loix]

Fo_Edt_Qpons

[Paek Conmuriclcr Z






Step 3 
Il testo del tuo messaggio viene inviata e contemporaneamente viene inserito nella finestra superiore con colorazione in verde. Quando la persona risponde il suo testo apparirà in colore blue appena sotto il tuo. In questo modo puoi avere una conversazione scorrevole. 
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Per effettuare un collegamento vocale singolo 

PalTalk ti consente facilmente di gestire una conversazione audio singola con un altro utente di PalTalk. Per attivarla basta aprire una finestra di comunicazione con la persona con la quale si desidera parlare e premere il bottone CALL. Se la persona accetta la vostra chiamata, sarai automaticamente connesso con essa.
Quando sei collegato con qualcuno , il colore di sottofondo della finestra di comunicazione cambia a blue marino. Un blu marino di sfondo indica anche che si sta avviando una connessione audio. PalTalk usa lo stesso colore blu di sottofondo per distinguere i gruppi vocali dai gruppi di solo testo. Solo i gruppi di testo hanno un colore rosso di sottofondo.
Quando vi trovate in una conversazione audio con qualcuno , vedrete anche una icona con un telefono con cornetta alzata accanto al nome nella lista dei nomi di paltalk. Un colore rosso dell’icona della cornetta indica che quella persona è già in conversazione con qualcun altro. 

Durante una comunicazione audio , appaiono due barre con cursore orizzontale nell’angolo sinistro in basso della finestra di comunicazione. Quella vicina all’icona del microfono  è il controllo del volume del vostro microfono. Se alzate il volume spostando il cursore a destra, aumentate il volume del segnale di uscita, cioè il volume che l’altra persona ascolterà. 

Il cursore della barra vicina all’icona del parlatore, è il controllo di volume del vostro sistema di altoparlanti. Questo è il volume che sentite. Il misuratore del volume degli altoparlanti può risultare ridondante, se avete un controllo manuale sugli altoparlanti; ma non tutti gli altoparlanti possiedono questo controllo.
Se alscoltate qualcuno ma il suo volume è molto basso , potete alzare il vostro volume di altoparlante oppure invitare l’atro ad alzare il volume del suo microfono.

Per disconnetersi da qualcuno , potete o premere il bottone Hang-up nella finestra di comunicazione oppure cliccare con il tasto destroy del mouse sul nome della persona nella vostra lista di amici e scegliere l’opzione Disconnect. 
Attenzione. – Attivando un contatto audio con un’ altra persona create un collegamento tra I due vostri computer. Può risultare possibile per l’altra persona ottenere il vostro indirizzo IP da questo link. Non attivate quindi una connessione audio con una persona alla quale non desiderate comunicare il vostro indirizzo IP. Se usate il metodo groups per ottenere un contatto audio, il vostro indirizzo IP non è esposto. 

Passo 1
From the main PalTalk window, open up a communicator window to one of your online buddies by double clicking on their name in the Online Pals list or by single clicking on their name and pressing the Text & Video button. 
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Step 2 
Press the Call button. The person you are calling will be asked if they want to accept the call. If they agree, an audio connection is made. The background color changes to navy blue and the Call button changes to a Hang-up button.
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Step 3 
In the bottom left corner of the screen there are 2 slider bars. The mic slider controls the volume of your mic (your outgoing volume). The speaker slider controls the volume you hear through your speakers (incoming volume). The vertical white bar tells you when you are transmitting voice to the other party. Press and hold the Ctrl key to talk. The vertical bar should change partially to red to indicate you are talking. 
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Step 4 
When either party presses the Hang-up button, the call is terminated. 
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MAKING A ONE ON ONE VIDEO CALL 
PalTalk allows you to easily have a one on one video session with another PalTalk user. To do so, open up a communicator window to the person you wish to speak to and press the Video button. If the person accepts your video call, you will automatically be connected. 
When you are connected to someone for video, the communicator window expands to include two video capture windows. The window on the top is your self image. The video on the bottom is the video of the other party. It is possible to have a video session with someone even if one of the parties doe snot have a video camera. In that case, only one of the video capture boxes is live. 
Each video cam comes with own set of setup parameters. If you need to adjust these parameters, you can do so from within PalTalk. Select the Video Setup option underneath the File menu on the main PalTalk window. The default size that works well with PalTalk is a resolution of 176 X 144. If you adjust this number upwards, your image will appear bigger to the other person. Bigger images take longer to transmit so 
To end a video session, press the Video Off button. 
Warning - Establishing a video session with another person creates a link between your two computers. It may be possible for the other person to obtain your IP address from this link. Do not engage in a video session if you do not want your IP address exposed. 
Step 1
From the main PalTalk window, open up a communicator window to one of your online buddies by double clicking on their name in the Online Pals list or by single clicking and pressing the Text & Video button. 
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Step 2 
Press the Video button. The person you are calling will be asked if they want to accept the call. If they agree, a video connection is made. The screen is enlarged to include a live video of yourself and the person you are calling. The Video button changes to a Video Off button 
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Step 3 
When either party presses the Video Off button, the call is terminated. 
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JOINING A GROUP 
PalTalk groups are rooms that you can join to exchange text and audio with many people at the same time. At any one point in time there are hundreds of active rooms on all sorts of subjects. 
To access the groups, press the Groups button. A group list window will be displayed with the various categories of groups and how many groups are in each category. Double click on the category of interest and view the groups in that category. Double click on the group itself joins the group. 
In the group list you will see three columns besides a groups name. These are the R, V and L columns, The R column stands for rating and will be populated with the letters G, R or A. The ratings equate mainly to movie ratings PG, R and X. The V column for voice indicates whether the group is audio enabled or text only. Audio enabled groups will have a mic icon in this column. The L column for Locked identifies those groups that may only be entered if you know the password. A padlock icon will appear in this column for locked groups 
Once you have joined a group you will see a screen that looks like a communicator window screen with a list of members running down the right hand side. Anything you type into the group gets seen by the entire group. If it is an audio group, anything you say will be heard by the entire group. Audio enabled groups have a navy blue background; text only groups have a red background. 
Only one person may speak at a time in a group. To speak, hold down your Ctrl key and speak into your mic. If someone had the mic ahead of you, a brick wall icon will appear by your name. This indicates you are temporarily blocked form sending audio because someone got the mic ahead of you. If you press the Ctrl key and you get a mic icon next to your name, you may speak into your mic and transmit to the group. 
In an audio group, two slider bars will be displayed in the lower left corner of the screen. The slider bar next to your mic icon is your output volume control to the group. To lower your volume, slide it to the left, to raise it slide it to the right. The slider bar next to the speaker icon, is the volume control for your own set of speakers. This is the volume you hear. The speaker volume slider may be redundant if you have a manual volume control on your speakers, but not all speakers come with that convenience. 
It is possible to initiate one on one conversations with people in the group. To do so, click on their names in the member list and press the Private button. A one on one communicator to that person will open. 
It is possible to create a new group. A group exists so long as there are people in it. You may optionally choose to create one group for yourself for which you are the admin. Admins have the ability to control who may speak on the mic and to remove people from the group if they become disruptive. To setup your group to be an admin of, choose the Setup option under the Admin menu in the Group List window. 
Step 1
From the main PalTalk window, press the Groups button. A Group List Window will open up. 
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Step 2 
The groups are organized into categories. Double click on a category of interest and you will see a list of the actual groups in that category. 
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Step 3 
Double click on a group you wish to join. A group window will open. The people who are currently in the group are displayed in a member list on the right. To send a text message into the group, simply type your text message in the bottom text box and press Enter. Your message is now sent to the entire group and is included in the running text conversation in the top text box. 
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Step 4 
If you have joined a voice group (had a mic icon next to it in the group list) you may speak into the group by holding down the Ctrl key and speaking. Only one person may speak at in a group at one time. If you press the Ctrl key and someone has grabbed the mic ahead of you, you will see a brick wall icon by your name. If you get the mic icon, you are transmitting to the group. 
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VIEWING AND PUBLISHING MULTIVIDEO
After you have joined a group, you can view others' video and publish your own video to the group.
Step 1
Click on the 'View Video' button. Your group window will expand to include 3 video screens.
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Step 2
Click on the drop down list to select the person you wish to see.
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Step 3
Click on the 'Start Publish' button so that others can view your video. Note: Anyone in the group will be able to see your video.
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SENDING A FRIEND AN INVITATION TO JOIN PalTalk 
If you enjoy using PalTalk you may like to send an invitation to a friend to join as well. We make this easy for you. All you have to do is give us their email and we will send them an invitation on your behalf. 
We can even save you the trouble of typing in the email. PalTalk can search your computer for the list of emails you commonly use. It then will present them to you as a list and you can select which ones you would like to send an invite to. 
PalTalk often runs give away promotions to encourage you to invite your friends. Check out our home page for details. 
Step 1
Select the Invite button from the main PalTalk window. A window pops up asking you for the email account of your friend. 
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Step 2 
Enter the email and press the Send Invite button. Your friend will receive an email invitation to join PalTalk. When they join they will automatically appear on your buddy list.. 
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Step 3 
You may optionally choose to let PalTalk find the email addresses of your friends for you by asking it to search the emails you have already stored in your email client's software (like Eudora, Outlook ...) To do this simply press the Choose Pals from My Address Book button. A list of emails found will be displayed to you and you will then have the option to select as many of them as you would like to send a PalTalk invitation to. 
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Step 4
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PalTalk USER INTERFACE
Client Interface
Communicator Interface
Group Window Interface
Group Chat Interface
Multivideo Window Interface
PalTalk CLIENT INTERFACE
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PalTalk COMMUNICATOR WINDOW INTERFACE
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PalTalk GROUP WINDOW INTERFACE
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PalTalk GROUP CHAT INTERFACE
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PalTalk MULTIVIDEO WINDOW INTERFACE
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USING PalTalk
Deleting a PalTalk nickname

How Do I Use PalTalk Plus 6 So I Can View 6 Cams?
Hands Free Voice Operation
Using PalTalk Profiles
File Transfer
Privacy/Blocking - limit who contacts you
Indicate you are away from the computer
How to create your own group
Testing your internet connection
PalTalk Plus
Favorites

DELETING A PalTalk NICKNAME 
Step 1
At the logon screen click on the button with three dots located next to the Nickname field.
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Step 2 
Select the name you wish to delete and click on the Delete Acct. button.
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How do I use the new PalTalk Plus 6 Camera Setup? 
 

    1. In order to use the new 6 camera setup, you must first download PalTalk 5.0 Final (461). You may do this by clicking HERE.
    2. Once downloaded, install the new software. Once setup has completed sign on to PalTalk.

    3. If you're a PalTalk Plus 6 Subscriber, or in one of our FREE demo lobbies, When you click on "SHOW VIDEO" button a new drop down menu will appear, below the 3rd camera screen. It will have a picture of a "Plus 6 Globe" to the right of it. This is your 6 Camera Selector.

    4. You may use this selector box to select your first 3 cameras, then continue to select users in the drop down, until you reach your maximum of 6, the 4th, 5th and 6th camera windows will appear to the left of the PalTalk Software. These are what we call "Floater" windows.

    5. Enjoy! The new camera screens are all resizable, you can resize them up to full-screen or as small as you want. Remember only PalTalk Plus 6 Subscribers or users in our demo lobbies will see the the new setup, also the new cameras have the ability to move at a rate of up to 6 frames per second.

Please Note: If you're not a PalTalk Plus 6 subscriber, or are not viewing in one of our demo lobbies you will not be able to see the 6 camera setup. If you would like to become a member of PalTalk Plus 6 Click HERE, by Subscribing you will be able to view the 6 camera setup, throughout the entire PalTalk Service.


HANDS FREE VOICE OPERATION 
There are two modes that you can choose from to tell PalTalk when to transmit your voice. The default mode is called Ctrl Key mode. In that mode PalTalk works like a walkie talkie. Press the Ctrl key to talk and release it to listen. 
Hands free voice mode is an option that you can turn on, which will allow you to talk without the need to press the Ctrl key. The key concept in this mode is the idea of a threshold. The mic you use is constantly picking up sounds even when you are not speaking into it. When you talk directly into it, it picks up a greater amount of sound. When the sound level reaches a certain threshold, PalTalk will transmit your voice. 
The idea here is that you must set this threshold so that when you talk directly into the mic, the sound volume is over the threshold, but when someone is talking to you (and their sound is coming out your speakers), that the level of sound volume coming into the mic does not reach the threshold. This mode works best when you are using a headset because the sound when the other person is talking goes directly into your ear and is not picked up by the mic. It can however be configured to work well with speakers and a standard mic, if you play with the threshold meter and perhaps the placement and volume of your speakers relative to the mic.
In hands free mode the vertical bar meter that is normally there during any voice conversation now has a horizontal line added to it. The horizontal line is the threshold and you can move it up or down by using the arrow buttons right next to the meter. 
Step 1
Under the options menu on the main PalTalk window there is a checkbox menu item called Hands Free Mode that you should check on. 
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Step 2 
A confirmation box is displayed asking you to confirm your choice. The hands free mode works well only if it is configured correctly. This confirmation box is warning you of that. Click on the Yes button to proceed. 
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Step 3 
When you are in a one on one call, you will now see a line in the vertical bar meter. This is the threshold line. You may move it up and down with the small arrow keys next to it. You want to adjust this line so that when you are talking into the mic, the red goes above the line and when someone is talking back to you, the red stays below the line. 
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USING PalTalk PROFILES 

On the file menu of your Pal List Window you will find 
a selection called 'PalProfiles'. There are 4 selections 
available under this menu. 
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Create / Edit My Profile 
Make this selection to create or modify your profile. 
You may fill in as much or as little detail as you like. 
The more detailed your profile is, the better chance 
you have when being matched up in InstaDate groups. 
Your profile may be kept invisible if you like. 
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View Profile 
Lets you view your own profile. You should always take 
a look at your profile when you are done setting it up 
or modifying it, just to be sure you are happy with it. 
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Search / Send Msgs Other Profiles 
You can search for people of similar interests and leave 
them messages. Both of your identities are protected 
with an anonymous id number. 
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Get Messages 
Retrieves messages that have been left for you by other users. 
If you have messages waiting you will be notified when you log in. 
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FILE TRANSFER 
PalTalk allows you to easily transfer files to any of your online buddies. To file transfer, simply bring up a communicator window to one of your online buddies and press the Send File button. 
You will then be asked to specify what file you wish to transfer. There is no set limit on the size of the file that you can transfer. 
Warning - Transferring files is a common way to spread computer viruses. A computer virus is a malicious program that destroys files on your computer. The virus hides inside the file being transferred and is released into your computer when you open the file being transferred. . When one user sends a file to another user, PalTalk has no way of knowing if that file contains a virus. It is up to you to use common sense to protect yourself from this threat. Always use a virus scanning program to check a file that you have received over the net before you open it. It is also a good idea to accept files only from people that you know. 
Warning - Establishing a file transfer with another person creates a link between your two computers. It may be possible for the other person to obtain your IP address from this link. Do not engage in any file transfer operations if you do not want your IP address exposed. 
Step 1
Right click on the person in your buddy list and choose the File Transfer option or bring up a communicator window to someone and choose press the Send File button.. 
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Step 2 
A standard windows dialog box is displayed asking you to choose the file to send... 
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Step 3 
You may optionally choose to let PalTalk find the email addresses of your fiends for you by asking it to search the list of emails you have already stored in your email client's software (like Eudora, Outlook ...) To do this simple press the Choose Pals from My Address Book button. A list of emails found will be displayed to you and you will then have the option to select as many of them as you would like to send a PalTalk invitation to. 
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PRIVACY/BLOCKING - LIMIT WHO CONTACTS YOU 
PalTalk allows you to limit who can contact you. You can limit groups of people by adjusting your Privacy setting or you can limit individual people from contacting you by blocking them. 
There are three privacy settings to choose from 
1. No restriction (the default) Allows anyone to contact you. 
2. Restrict who can call you to those people on your buddy list. Anyone can still text message you. 
3. Restrict who can text or call you to those on your buddy list. 
When you block someone, you block that person from communicating to you in anyway. To them you will always appear as if you are not online. 
Step 1
From the main PalTalk window, press the Setup button. A tabbed setup window will appear. 
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Step 2 
Choose the Privacy/Blocking tab. The appropriate tab is displayed. 
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Step 3 
The Who can contact me box allows you to choose one of three options. The first and default option is to allow anyone to contact you. The second option allows anyone to text message you but only people on your pal list can call you. The third option which is the most restrictive, allows only calls and text from people on your pal list.
[image: image46.png]Paltalk Setup

2]
Adverced S Canl | PotakPonSetiogs | TetCarecion |
Mytdo PivayBlckiny Prerce:
Who oncotctne?

[ Ak s CanCorat Mo
o fomPat O, e Cht o rpore
[ o Gt oo Oy

Bk L onsoerert





Step 4 
If you wish to stop one specific person from contacting you, you may add them to your block list. Persons on your block list always see you as offline and are prevented from contacting you. The block list window is mainly a place to see and optionally remove your existing blocks. There are many different ways to block someone.
· From this window, press the Add Block button. 
· From the pal list, right click and choose block 
· From a communications window, choose block under options menu 
· When someone tries to contact you, there is always an option to block them.
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INDICATE YOU'RE AWAY FROM THE COMPUTER 
If you have PalTalk running and you wish to leave your computer for a short period of time, you may wish to tell your buddies that you are away from the computer. You can do this my putting yourself in away mode. 
Anyone who has you as a buddy will still see your name in their online buddy list, but your name will be grayed out and an open door icon will appear next to your name. 
When you put yourself in away mode, an I'm Back button appears at the bottom of your main PalTalk window. When you return to your computer, you simply press this button to return to your normal mode. 
Step 1
Select the I am Away option under the Options menu in the main PalTalk window. 
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Step 2 
Everyone who has you as a buddy will see that your name has grayed out and an open door icon is next to your name indicating that you are away 
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Step 3 
To return to your normal state, click on the I'm Back button. 
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HOW TO CREATE YOUR OWN GROUP 
It is possible to setup one group for which you are the administrator of the group. Being an administrator allows you to moderate the room by giving you the power to take away a person's microphone (if it is a voice group) and the ability to bounce (remove) a person in the event that they are extremely disruptive or abusive. Your nickname will be identified as an admin account in your group by having an @ sign precede your name. The @ sign indicates admin capabilities. PalTalk personnel have admin capabilities in all groups they enter. They are differentiated from room admins by having their nickname appear in red in addition to having the @ sign. 
When you create a group, you will have the option of specifying a lockword or not. If you specify a lockword, anyone trying to join your group will be asked to specify the lockword before they are allowed to enter. In this way, you can control who may enter your room by who you tell the lockword to. If you do not specify a lockword, the group is open to everyone. 
You may allow an unlimited number of people to co-admin your room with you. When you create the group, you will be asked to specify a 4 digit admin code. The admin code is the key to your room. Anyone who knows it can open or join your room as an admin. 
When setting up a group to admin you must supply the following information 
Group name - The name of the group. You are not allowed to make any group with a title that defames, disparages or excludes any race, creed, religion, age group, gender, national origin, or any other organization, business entity or individual person. You also may not make any group that condones or promotes the use of drugs, encourages software piracy, child pornography, or any other illegal activity. You may not make a group which promotes any commercial organization or activity without express permission from the PalTalk business office. 
Category - PalTalk groups are organized into categories. You will have to select from a drop down list which category you prefer your group to be found in by others. 
Rating - Similar to a movie rating. The options are G, R or A. G rated rooms must be suitable to all audiences including minors. Text in G rooms is automatically filtered to eliminate possible offensive language. R and A rated rooms are suitable for adults only and the text is not filtered what so ever. The difference between these two groups is that an A rated group allows sexually explicit language where an R group does not. 
Voice Enabled Switch - On indicates that you want to allow voice in the room, off indicates that it will be a text only room. 
Admin Code - A 4 digit numeric code that is the key to joining your group with admin privileges. Select a code that is easy to remember. Share this code with those people you wish to help you co-admin your room. 
Lockword - An optional field. If you specify a value in this field, anyone not knowing your lockword will be prevented from entering your room. Anyone trying to join your group will be asked to specify the lockword before they are allowed to enter. 
Intro Message - An optional field. If specified, every time someone joins your group, they will be automatically greeted with this message. 
Bouncing Someone - If someone is being severely offensive or disruptive, you have the power to bounce them from the room. To bounce someone, you right click on their name, select Bounce, and then supply a reason why you are bouncing the person. All bounces are monitored so anyone abusing this power will quickly lose their room. When someone is bounced, they may not reenter your group for 24 hours. 
Bouncing Caveats - We track how many bounces an admin does per day and overall. If the number of bounces per day is high, all users entering your group will receive a warning similar to the following: 
Room admins in this group HAVE AND DO frequently use the power to remove members at their discretion to maintain an orderly room as they see fit. If this is unacceptable to you, please leave and visit one of our many other rooms. 
If the number of bounces is excessive overall, the group may be closed down permanently and your account restricted from creating new groups in the future. 
Muting Someone - (voice groups only) By double clicking on someone's name, you can change the colored dot in front of them from green to red and back again. Green indicates they can talk, red means they cannot. You would use this for example to take the microphone away from someone who is talking too long or is deliberately trying to tie up the room. Normally you would take the microphone away and then soon after, give it back. 
Muting Everyone - It may be desirable to mute everyone's microphone except your own to help moderate a room. You then can choose to individually turn someone's mic on, let them speak, and then take the mic away. To do this, select the "Remove All Mics" option under the "Mics" menu. This will remove all the mics from everyone except yourself. New people joining the group will default to having their mic turned off. To restore everyone's mic back, choose the "Give Mics To Everyone" option under the "Mic" menu. This will restore everyone's mic and new people joining will default to their mic being on. 
The Static Text MSG -When your group is open, you will find that right below the banner area is a static text field. You can use this field to display a message to your users that will stay on the screen and not scroll off. Some examples of how to use this field are to display a URL to a web site of interest, or to display a welcome message, or perhaps to display a topic of the day. You have the ability to change this field at any time by simply typing over what is currently there and hitting Enter. This area is only editable to the group admins. Your members see this field all the time but cannot not modify it. 
Closing the group - You may desire to close your group down for the day. Perhaps you wish to log off and do not want your group open while you are not around. Another reason to close your group down is if you have made changes to the group's definition using this facility and you want to pick up the new changes. Changes are picked up when the group is opened, so if you make changes to your group while the group is already open (example change it's name), the change will not be reflected until the group is closed and reopened. There are two ways to close a group. When all members have left the group, the group is automatically closed. Alternatively you may wish to forcibly close the group while it still has members. To do so, you enter the following, ..close into the static text area. That is, two dots (periods) followed by the word, close, and hit Enter. The room will close down immediately. Note - changing your admin code is always immediately reflected and does not require you to close and reopen your room to pick up that one change. 
Admin Code and How to open the group - When you create a permanent group, you will have to specify a 4 digit admin code. This admin code is the key to opening your room. To open your room you must do the following. Bring up the Groups List window by pressing the Groups button on the main screen. Select the "Open or /Join Group as Admin" option under the File menu. You then specify the admin code and hit the OK button. Your group will open automatically 
Co administrators - You may allow an unlimited number of people to co-admin your room with you by telling them your admin code. Anyone who knows your admin code can open or join your room as an admin. The procedure for them to open or join your room as admin is similar to how you open up the room. They must select the "Open or /Join Group as Admin" option under the File menu, then select your nickname from the dropdown list and then they must specify your admin code. The group will open automatically. If you wish to change who may co-admin your room with you, you simply change the admin code. Pick your coadmins wisely because you are responsible for their actions as well as your own. Violations of these guidelines by you or your coadmins will cause the loss of your room and the ability to create new groups in the future. 
Step 1
You may setup one group for which you are the admin of. The admin can control who speaks on the mic and remove people from the group who are being disruptive. There is a one time process to initially setup your group. Press the Groups button on the main PalTalk window to bring up the Group List window. Select the Setup option underneath the Admin menu. 
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Step 2 
You will be presented with a login screen. Enter your nickname and password that you use to log into PalTalk. 
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Step 3 
You will be presented with an admin guidelines document. You must read this document to continue. Somewhere within this document is a keyword that you must find and type in to continue. 
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Step 4 
You will be presented with a form that you must fill out. This form defines your group, it's name, rating, category, etc. One field you will be asked to enter is a 4 digit admin code. The admin code is the key to your room. Anyone who knows your admin code can enter your room with the same admin capabilities as you. Share your admin code with those people you wish to co-admin your room with you. You may at any time change the admin code if you change your mind about who the coadmins would be. 
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Step 5 
Once your group has been setup, you only need to open it whenever you wish to use it from that point on. To open your group go back to the Group List window and choose the Open option under the Admin menu. 
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Step 6 
Enter your 4 digit admin code and press OK. Your group will open. To open or join someone else's group for which you are privy to their admin code, select there name from the Group Owner's dropdown and then enter their 4 digit admin code. If their name does not appear in the dropdown list, adding them as a buddy will also add them to the dropdown list. 
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TESTING YOUR INTERNET CONNECTION 
PalTalk allows you to test/ping you current internet connection. 
This ping test will determine the speed and general quality of your Internet connection. You may find that your ISP causes delays and problems with your sound quality. Use this metric to help you determine the root cause of your sound difficulties.

NOTE: This Does NOT Fix your internet connection or improve it, All that the Network Test does is give you a reading on how long it takes a request to get from your computer to the host computer and back. (ICMP PING).
You must be able to use an ICMP ping in order for this test to work. Adjust your firewall to allow an outbound ping. Windows95 users need the Winsock2 patch to use this feature.
Step 1
From the main PalTalk window, press the Setup button. A tabbed setup window will appear. 
[image: image57.png][© rar o

Elo_Qors_teb

Onine Pot:
Patalkdmint
cagevsalon
Ol Pt

- v

® [Comeciedto PaServr




Step 2 
Choose the Test Connection tab. The appropriate tab is displayed 
[image: image58.png]eI x|

Woido | Pcylokig | _Primences |
AdvercedSoundCarcl | PotohPot St

Notwk P Tt
[ ———
Qs sl corcscon Youmo i ht
s 8P G s o e vt s
Ty Use s e oo o et
il ol o s s

[Eottoiten] Hot Frator

NOTE: Youmusbe sl se | OHF pgi
ks s et towerk, Akt ps ol 1>
S b WiotS s s
Wack 2paich o s e

k| o || s |





Step 3 
This is where the test connection process takes place. To start the test, click on "Start Network Test" PalTalk will now test/ping your current Internet connection and come back with details. 
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Step 4 
Details of your connection are shown in this box. Also with a comment. e.g. "poor" "average" "good" etc..
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How To Sign Up To PalTalk Plus
PalTalk is a free service which supports itself financially by displaying banners to our user base. You may opt to run PalTalk without having to have to see banners. 
This gives you two immediate benefits, one, obviously you don't have to deal with all the banner displays. The second benefit is that the banners are not being downloaded to you. This means that none of your bandwidth is being used to download banners. This could improve the quality of your sound if you are using a dial up connection. 
We offer this option for a small fee. $9.95 for 3 months or $24.95 for a full year. 
Step 1
To select this option click the link below and press the Subscribe button go sign up for the PalTalk Plus option.
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Step 2 
Fill out the displayed form. You will be asked basic name and address information and for credit card info. The next time you log into PalTalk after filling this screen out, you will no longer see banners. 
[image: image62.png]




FAVORITES MANAGEMENT
PalTalk can remember the groups you visit frequently and make it easy for you to renter them. From within any group that you wish to revisit regularly, you should choose the Add to Favorites selection under the option menu form within the group. 
This will add the group you are currently in to a list of favorites. The favorites list can be accessed from the menu off the group list window making it easy for you to reenter quickly any group on your favorites list. 
Step 1
From the main PalTalk window , press the Groups button. This opens up a group list window. 
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Step 2 
Click on the Favorites menu item. A drop down list of your prior group favorites will be displayed. To join one of these groups, simply select it. 
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Step 3
To add a group so that it appears the next time in your favorites list, join a group as usual and then choose the Add to Favorites selection under the Options Menu. 
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Step 4
From the groups list window, select Favorites Management option under the Favorites menu. Select the group you wish to delete and press the Delete button. 
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